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40 SYSTEMS Workshaop 4 User Guide

1. Description

This user guide provides an introduction to Workshop 4, the 4D Systems integrated development environment.

Workshop 4 supports multiple development environments for the user, to cater for different user
requirements and skill level.

The Designer environment enables the user to write 4DGL code in its natural form to
program the 4D Systems module of choice.

Designer
7

A visual programming experience, suitably called ViSi, enables drag-and-drop type
placement of objects to assist with 4DGL code generation and allows the user to visualise
how the display will look while being developed.

An advanced environment called ViSi-Genie doesn’t require any 4DGL coding at all, it is all
done automatically. Simply lay the display out with the objects required, set the events to
drive them and the code is written for the user automatically. ViSi-Genie provides the
Vis i em'e' latest rapid development experience from 4D Systems. (Not available for Goldelox)
N —

A Serial environment is also provided to transform the 4D Systems module into a slave
serial module, allowing the user to control the display from any host microcontroller or
device with a serial port.

Serial
N —

To install Workshop 4, please refer to the document Workshop 4 Installation.
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40 SYSTEMS Workshaop 4 User Guide

2. Workshop 4

There is an alias for 4D Workshop on the desktop:

? € omSme B A

Launch 4D Workshop by double-clicking on the icon:

workshop
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40 SYSTEMS Workshop 4 User Guide

. Create a New Project

Workshop 4 opens and displays the Recent page:

1=1E Workshop 4 - NoName2(uLCD-32PT, LANDSCAPE) | =)

m Home | View Tools Widgets Comms Project (S
| New

Recent
SOUNDPLAYER.4DGenie

|L Open

14/03/2012 12:32 p.m.

B ProgramData|Documents 4D Labs\PICASD Visi
Genie|\SOUNDPLAYER\SOUNDPLAYER.4DGenie

FANCYBUTTONS.4DViSi 24/12/2011 1:30 pam.
Eﬂakvae'ngjx ProgramData\Decuments\4D Labs\PICASO 4D-
\FANCYBUTTONS 40ViS

IMAGECONTROLKBD.4DG 22/102012 3242 p.m.

3 uments\4D Labs|\Pice - MAGE
CONTROLVIMAGECONTROLKEDADG

-‘_H Zip Project BUFFEREDTX.4DG 6/06/2010 1:33 a.m.
C:\ProgramData|Documents 4D Labs|PICASO GFX2\PICASO - SERIAL

ﬂ Close Wo R KS H o P Version 4.0.2.1 COMMS\BUFFEREDTX.4DG

COMCHECK.4DG 6/06/2010 1:41 a.m.

9 Print Setup mc:\u Data\Documents 4D Labs\PICAS 0- SERIAL
- COMMS\COMCHECK.4DG.
A " z Create a new Project SLIDETRACK.4DViSi 8/11/2012 1:50 p.m.
' ’ Start building a new Visi, Genie, Designer y
= or Serial program ProgramData\Documents\4D Labs\Picas o Visi\SLIDETRACK4DVIS
1% options
»,3} " SWITCHANDKNOB.4DVisi Wiy 552 pm,

Users\Public\Documents\4D Labs\Picaso
@ Help Visi\SWITCHANDKNOB.ADViS
A MP3-Player.4DVisi 4/11/2012 1:34 pum,
sarmples Create a new Project
w Start building a new program using the. Data\D DL PlayeraDvis
same settings as you last used (Visi
x . uLCD-32PT) FANCYBUTTONS.4DViSi 21/12/2011 1:30 p.m.

ProgramData\Documents\4D Labs\Peas
'VisT\FANCYBUTTONSADVIS

MPp3-Player.4DVisi 4/11/2012 1:34 p.m.

To create a new program, there are multiple options:

e  Click on the top left-most icon New
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40 SYSTEMS Workshop 4 User Guide

e C(Click on the upper Create a New Project if creating a project from scratch, or click on the lower Create

a New Project to use the settings and module that was used last time:

WORKSHO P Version 4.0.2.1

Create a new Project
Start building a new Visi, Genie, Designer or
Serial program

Create a new Project
Start building a new program using the same
settings as you last used (Visi-Genie
ulCD-32PT)

Choose Your Product, simply select the 4D Systems module of choice to start your development:

CHOOSE YOUR PRODUCT

MPOLED-96-G2
lﬂ.‘}s" Intelligent OLED maodule

HOLED-128-G2 128x128
1.5" Intelligent OLED module

POLED-160-G2 128x160
1.7"Intelligent OLED module

PLCD-144-G2 128x128
1.44" IntelligentLCD Module
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HLCD-24PTU 240x320
2.4"QVGA Intelligent Touch Screen LCD Module

pLCD-28PT 240x320
2.8" QVGA Intelligent Touch Screen LCD Module

HLCD-24PT 240x320
24" QVGA Intelligent Touch Screen LCD Module

Select the product, in this case the uLCD-32PT Display Module:

¥ pLCD-32PT 240x320
3.2" QVGA Intelligent Touch Screen LCD Module

o]
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40 SYSTEMS Workshaop 4 User Guide

The selected module is displayed on the right hand side:

CHOOSE YOUR PRODUCT

pLCD-24PT 240x%320
2.4"QVGA Intelligent Touch Screen LCD Module

PLCD-24PTU 240x320
24" QVGA Intelligent Touch Screen LCD Module

PLCD-28PT 240320
2.8" QVGA Intelligent Touch Screen LCD Module

o] o]

pLCD-32032-P1 240x%320
3.2"QVGA Intelligent Touch Screen LCD Module

Portrait (Click image to rotate)

HLCD-32PT 240x320
3.2"QVGA Intelligent Touch Screen LCD Module

HLCD-28PTU 240x320
. 2.8" QVGA Intelligent Touch Screen LCD Module

PLCD-32PTU 240x320
. 3.2"QVGA Intelligent Touch Screen LCD Module

Orientation is portrait by default.

To set it to landscape, just click on the image of the display to rotate it. Additional clicks rotate the display by
90 degrees:

CHOOSE YOUR PRODUCT

pLCD-24PT 240x320
24" QVGA Intelligent Touch Screen LCD Module

pLCD-24PTU 240x%320

l 2.4" QVGA Intelligent Touch Sereen LCD Module
pLCD-28PT 240x320
2.8" QVGA Intelligent Touch Screen LCD Module

pLCD-28PTU 240%320
2.8" QVGA Intelligent Touch Screen LCD Module

¢ pLCD-32032-P1 240x320
3.2"QVGA Intelligent Touch Screen LCD Module

HLCD-32PT 240x320
3.2"QVGA Intelligent Touch Screen LCD Module

pLCD-32PTU 240x320
. 3.2"QVGA Intelligent Touch Screen LCD Module

Press Next to proceed:

© 2012 4D SYSTEMS Page 8 of 36 www.4dsystems.com.au
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40 SYSTEMS Workshaop 4 User Guide

4. Choose Your Environment

The main window now asks for the environment for the project:

~

== Workshop 4

| CHODBOSE YOUR ENVIRONMENT C““m@ Seste

System Text
L Open e File File
|- Recent

E Designer
=
v
The Designer environment enables the user to write 4DGL code in its A visual programming experience, suitably called ViSi, enables drag
natural form to program the display module. and drop type placement of objects to assist with 4DGL code
1“ generation and allows the user to visualise how the display will look

while being developed.
A

’3} Options N - ViSi Genie

An advanced environment called ViSi-Genie doesn't require any 4DGL
coding at all, it is all done for you. Simply lay the display out with the
@ Samples objects you want, set the events to drive them and the code is written
for you automatically. ViSi-Genie provides the latest rapid
x it development experience from 4D Systems.
i

o

P

Four main environment options are available:

e Designer,

e ViSi,
e ViSi-Genie,
e  Serial

...and two editor options:
e  Create System File,

e (Create Text File.

Each option opens a customised environment with specific commands and controls.

Different projects using different modules and environments can be open simultaneously on Workshop 4. The

toolbar ribbon will adapt to the project tab that is selected, to suit its environment.

© 2012 4D SYSTEMS Page 9 of 36 www.4dsystems.com.au




40 SYSTEMS Workshop 4 User Guide

1. Designer

Designer

The Designer environment enables the user to write 4DGL code in its
natural form to program the display module.

The Designer environment enables the user to write 4DGL code in its natural form to program the display
module. 4DGL is a graphics oriented language allowing rapid application development, and the syntax structure
was designed using elements of popular languages such as C, Basic, Pascal and others.

| [orkshop 4 - NoNamel*(uLCD-32P°

Home  Tools Comms Project

N New ES“EAS # B copy & undo = \ @ @ < /)\ @ @ ‘:\Q = Collapse Al & Compile
|\ Open A Frint ) Jipeste | @redo "é “é B Ebpandall | ¥ CompnLoad

(\V)
0
2
]
| -
Y]
n
>
N
Q
(@]
L
n
RV
| -
=

cut ClearAll  Next Prev  Set Find Replace Goto Find Again
= & Delete . :
File Clipboard Undo/... Bookmarks Find Code Folding Compile
4p
Sl o | < ey oY o
1 |#platform "uLCD-32PT_GEX2"
#2 | /7 Designer
Z |#inherit "4DGL_1ébitColours.fnc"
5 |fune main()
gfx_ScreenMode (LANDSCAPE) ; // change manually if orientation change
] print ("Hello World") : // replace with your cods
11 repeat // maybe replace
12 forever // this as well
"4 |endfune
Insert Line:2 Col:8

To learn more about Designer, please to refer to Designer User Guide and the related application notes.
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40 SYSTEMS Workshaop 4 User Guide

4.2. ViSi

A visual programming experience, suitably called Visi, enables drag and
drop type placement of objects to assist with 4DGL code generation
and allows the user to visualise how the display will look while being
developed.

A visual programming experience, suitably called ViSi, enables drag-and-drop type placement of objects to
assist with 4DGL code generation and allows the user to visualise how the display will look while being
developed.

[ - = orkshop 4 - NoName2*(uLCD-32PT, LANDSCAP

Home View Tools Widgets Comms Project

I New [g)saveas Da, i copy &3 undo <X @ @ < ’)\ @ @ /“ -i' # Compile
|/| Open s Print Jiraste | & Redo - 6 L é Y L] —_— = 3 Comp'nLoad
cut C Clear Al Next Prev  Set Find Replace Goto Find Again  CollapseAl Expand All
= P Delete . i
File Clipboard Undo/... Bockmarks Find Code Folding Compile

0] EN [voremez- [ O | =

$1 |#platform "uLCD-32PT_GFX2"
2| s/ visi
5 |// Program Skeleton 1.0 gensrated 12/10/2012 12:23:21

] »

S |#inherit "4DGL_lébitColours.fnc”

m

#inherit "VisualConstc.inc"
#inherit "NoName2Const.inc"
func main()

12 |// var mstrings : // Handle to access uSD strings, uncomment if required
3 |// var hFontx ; // Handle to a

s fonts, uncomment if required an

(\V)
0
2
]
| -
Y]
n
>
N
Q
(@]
L
n
RV
| -
=

14 |/ Uncomment the following if uSD images, fonts or strings used.
15 |/

Object Inspector

whils(! (disk : = _Mount()}) FnrmIForml v]
utstr("Drive not mounted..."):
4e putstr("Drive not mounted ): Obyect [Form1 3
20 pause (200) ; -
« I ] + | [ Properties | [[Paste Code | [Paste all Code
Name Form1
Batype Color
Color WsLack
Image one
[ source
Insert Line:1 Colil

To learn more about ViSi, please to refer to the ViSi User Guide and the related application notes.
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4.3. ViSi-Genie

ViSi Genie

An advanced environment called ViSi-Genie doesn't require any 4DGL
coding at all, it is all done for you. Simply lay the display out with the
objects you want, set the events to drive them and the code is written
for you automatically. Visi-Genie provides the latest rapid development
experience from 40 Systems,

An advanced environment called ViSi-Genie doesn’t require any 4DGL coding at all, it is all done for the user. By
simply laying the display out with the wanted objects and setting the events to drive them, the code is written
automatically. ViSi-Genie provides the latest apid development experience from 4D Systems.

> | | = o G@, Buttons Digits  Gauges  Primives  Iputs  Labek  SystemMedia @
= W il N C> - — '
Id I M) ¥ )
New Open Save SaveAs Prnt | Bui { D @@\ = ] ﬂ\[ ) U
File Build
4
[E x] \'{ =1, [Eivoames x] [ ] \'{ I,

Form0 5| | Object Inspector £

Form [Fnrmﬂ vI

Object [Farma -

Properties | Events

Name Form0

Bgtype Color
Color WsLack
Image Hone
Source

(\V)
0
2
]
| -
Y]
n
>
N
Q
(@]
L
n
RV
| -
=

Insert Line:l Col:l

To learn more about ViSi-Genie, please to refer to ViSi-Genie User Guide and the related application notes.
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4.4. Serial

The Serial environment is provided to transform the module into a slave serial module, allowing
communication and control from virtually any host micro-controller or device with a serial port.

This option is under development and is coming very soon.

4.5. Create System File

The Create System File option provides an editor for all 4DGL-related projects, so a user can create or edit a
4DGL Include file, 4DGL Library file, a Function or System file. These can then be included in the users 4DGL
code.

Home  Tools

(\V)
0
2
]
| -
Y]
n
>
T
Q
(@]
L
n
RV
| -
=

ldd=s « XK OB 0065 LOO &

New Open Save SaveAs Print Cut Copy Paste Delete Unde Redo Clear Al Next Prev Find Replace Goto Find Again
File Clipboard Undo/Redo Bookmarks Find

[E E\{ E\{ﬂ N NoName4.inc* [x] EI o

#1||// eper reratea

Insert Line:l Col:l
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40 SYSTEMS Workshaop 4 User Guide

4.6. Create Text File

Create
Text
File

The Create Text File environment features a plain editor, suitable for writing basic documentation, application
notes, data files or anything else requiring plain text files.

Home | Tools

|lm~%H4x@®é@@/€§)\@®ﬂ
New Open  Save SaveAs  Print Cut Copy Paste Delete Undo Redo Clear Al Next Prev Find Replace Goto Find Again
File Cliphoard Undo/Redo Bookmarks Find
4r
[E =] { 1x] {ﬂ L] [ 1% Nohames. tet= [x]
%1 |7/ other
Insert Linel Colg i

(\V)
0
2
]
| -
Y]
n
>
T
Q
(@]
L
n
RV
| -
=
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5. Common File Menu

The File Menu is the first menu and common to all environments...

=1 Workshop 4 - NoName2(uLCD-32PT, LANDSCAPE) (=& s

EE Home | View Tools Widgets Comms Project o
| New
| | open
C:\ProgramData|Documents\4D Labs|PICASD Vsl
o~ Genie\SOUNDPLAYER|SOUNDPLAYER.ADGenie
er |
FANCYBUTTONS.4DViSi 21/12/2011 1:30 p.m.
fah"e - C:\ProgramData\Documents|4D Labs\PICASD 4D-
e Visi\FANCYBUTTONS.4DVIS
—] IMAGECONTROLKBD.4DG 22/10/2012 3:42 p.m.
—_
B mc:\P Data\Documents\4D Labs\Pic: ICAS0 - MAGE
CONTROLVIMAGECONTROLKEDADG
-‘_H Zip Praject
C:\ProgramData\Documents 4D Labs\PICASO GFX2\PICASO - SERIAL

& Close Wo R KS H o P Version 4.0.2.1 COMMS\BUFFEREDTX.4DG

Recent
SOUNDPLAYER.4DGenie

14/09/2012 12:32 p.m.

BUFFEREDTX.4DG 6/06/2010 1:33 am.

= COMCHECK.4DG 6/06/2010 1:41 a.m.
& Print Setup mc:\u Data\Documents 4D Labs\PICAS 0- SERIAL
COMMS\COMCHECK.4DG.
. - z Create a new PI’O]eCt SLIDETRACK.4DViSi 8/11/2012 1:50 p.m.
Start building a new Visi, Genie, Designer
= D or Serial proggram < C:\ngramData\DntumEn(sHD Labs\Picaso Visi\SLIDETRACKADVIS
b
\,3} s SWITCHANDKNOB.4DViSi 11/11/2011 5:52 p.m.
C:\Users\Public\D ocuments\AD Labs\Picaso
@ Help Visi\SWITCHANDKNOB.4DVIS

MP3-Player.4DViSi 4/11/2012 1:34 pam.

Create a new Project
@ TS t ‘ Start building a new program Jsmg the c:\P Data\Decuments\4D Labs\Pic Player VS

same settings as you last used (Visi
R e

uLCD-32PT) FANCYBUTTONS.4DViSi 21/12f2011 1:30 p.m.

C:\ProgramData\Documents 4D Labs\Picaso
Visi\FANCYBUTTONS4DVIS

MP3-Player.4DVisi

4/11/2012 1:34 p.m.

..with various buttons relating to the project that is open (or greyed out if no project is open):

. File-related buttons,
. Print-related buttons,
. And miscellaneous buttons, such as Help, Options and Samples.

5.1. File-Related Buttons

The buttons include all the actions related to projects: New, Open, Recent, Save, Save As, Zip Project and Close
project.

(\V)
0
2
]
| -
Y]
n
>
N
Q
(@]
L
n
RV
| -
=

l_] New

|L Open

1_H Zip Project
l& Close
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The options include:

o Click New to create a new project. A dialogue window asks for the screen and the kind of project.

| CHOOSE YOUR PRODUCT

HOLED-96-G2
0.96" Intelligent OLED module

POLED-128-G2 128x128
1.5"Intelligent OLED module

POLED-160-G2 128x160
1.7" Intelligent OLED module

1.44" IntelligentLCD Madule

PLCD-24PT 240x320
2.4"QVGA Intelligent Touch Screen LCD Module

pLCD-24PTU 240x320
2.4"QVGA Intelligent Touch Screen LCD Module

PLCD-28PT 240x320
2.8" QVGA Intelligent Touch Screen LCD Module

3
-l
l pLCD-144-G2 128x128

Organize » New folder

s¥ Favorites MName Date modified

B Desktop &»| AN2 Getting Started 05/10,/2012 12:09 4DGEMIE File
& Downloads

3# Dropbox

E Recent Places

¢&. SkyDrive

TV enregistrée

(\V)
0
2
]
| -
Y]
n
>
N
Q
(@]
L
n
RV
| -
=

- Libraries
il 4D Systems
@ Documents
J’ Music
[E] Pictures
B videos a1 !

File name: AMNZ2 Getting Started - I‘ul'isi Genie projects

l Open |v] l Cancel

Select ViSi-Genie projects among the different kinds listed below to load a ViSi-Genie project:

|1|.|"irsi| Genie Em'ﬁ vl
Designer projects
Visi projects
B 4DGL Misc files
All files

© 2012 4D SYSTEMS Page 16 of 36 www.4dsystems.com.au




40 SYSTEMS Workshaop 4 User Guide

o Click Recent to list the recently accessed files, and click on the project to open it.

1 = Workshop 4 - NoName2(uLCD-32PT, LANDSCAPE) (=] B

Eg Home | View| Tools Widgets Comms Project 3
| New
| | open
C:\ProgramData\Documents\4D Labs\PICASO Visi
- y Genie\SOUNDPLAYER\SOUNDPLAYER.4DGenie:
4

FANCYBUTTONS.4DViSi 211272011 1130 pm.

H Save
e

.
Lie
BUFFEREDTX.4DG

-‘_H Zip Project
mc \Pr Data\Documents 4D Labs\PICAS 0 - SERIAL

|G cose WORKSHOP  eionsozs R

COMCHECK.4DG 6/06/2010 1:41 a.m.
& Print Setup

Recent
SOUNDPLAYER 4DGenie 19/09/2012 12:32 p.m.

C:\ProgramData\Documents|4D Lahs\PICASD 4D-
Visi\FANCYBUTTONSADViS

IMAGECONTROLKBD.4DG 22/10/2012 3:42 p.m.

cp Documents|4D Labs\Pic: ICASD - MAGE
CONTROL\IMAGECONTROLKEDADG

6/06/2010 1:33 a.m.

E C:\ProgramDatalDocuments\4D Labs\PICASO GFX2\PICASO - SERIAL.
COMMS\COMCHECK.4DG

A . Z Create a new Project SLIDETRACK.4DViSi §/11/2012 1:50 pum.
‘ ' Start building a new Visi, Genie, Designer §
3 o Serial program o2l ok
!
1o OPUONS SWITCHANDKNOB.4DViSi 11/11/2011 5:52 pm.
C:\Users\Public\D ocuments\AD Labs\Picaso
@ e

MPp3-Player.4DVisi 4/11/2012 1:34 p.m.

( | Create a new Project
@ Samples t ‘ Start building a new program asmg the c:\P Data\Documents 14D LabsFic: PlayerDUiS

same settings as you last used (Visi
x Exit ) FANCYBUTTONS.4DViSi 21/12/2011 1:30 pum.

C:\ProgramData|Documents 14D Labs|Fcaso
Visi\FANCYBUTTONS4DVIS

MP3-Player 4DViSi 4132012 134 pm.

o Click Save to save the modified projects.
. Click Save As to create a copy of already saved project and give it a new name. A standard Save
window opens and asks for the location and the name:

1o < 4D-AN-1002-VG Getting... » AMN2 Getting Started - Search ANZ Getting Started 2

- TEEESS—S"S Teaaa—" " . -

Organize * MNew folder 4= - (7]
J¢ Favorites *  MName Date modified Type

Bl Desktop &#| AN2 Getting Started 05/10/2012 12:09 4DGENIE File

& Downloads

%+ Dropbox
“El Recent Places
i #& SkyDrive
TV enregistrée

(\V)
0
2
]
| -
Y]
n
>
N
Q
(@]
L
n
RV
| -
=

- Libraries
@ 4D Systems
@ Documents
&) Music AR I ¥

File name: AN2 Getting Started -

Save as type: ’Visi Genie projects v]

~ Hide Folders ’ Save ] ’ Cancel ]

e Click Zip Project to make a compressed file out of the project. This is especially useful when then
project is large and contains pictures and videos.
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e Click Close to close the current project. You will be prompted to save the changes to any modified
project.

. | Save Changes to AN4 - Customised keyboard. 4DGenie?

MNe H Cancel ]

5.2. Print-Related Buttons

The buttons include all the actions related to print:

Prirter

Mame: [I'H'Iicmsuﬁ ¥P5 Documert Writer

Status: Ready

Type: Microsoft XP5 Document Writer
Where:  XPS5Por:

Commert:

Faper Crientation

Size: [M @ Portrait

Source: [Mumaticall}r Select (71 Landscape

(\V)
0
2
]
| -
Y]
n
>
N
Q
(@]
L
n
RV
| -
=

oK) [ o
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Click Print to print the project:

Prirter

Mame: [I'H'Iicmsnﬁ XP5 Document Writer

Status: Ready

Type: Microsoft ¥PS Documert Wiiter
Where:  XPSPort:

Commert:

Print range Copies
@ Al Mumber of copies:

(") Pages from: 1

() Selection | _ﬂﬂ _2'3 _3@ Collate

S oKk | [ Cancel |
| -
V) 5.3. Miscellaneous Buttons
n
D The Miscellaneous buttons include Options, Help, Samples and Exit.
’k Options
Q o8
E @ Help
n
M @ Samples
| -
§ o oo
Click Options to set the options for the current project:
Ak Workshep 4
|- — |
UL oo [T ’T‘%ﬁ’”“‘”‘*m
o e s
E T cokr [l
3
&\ I RS R T
55
@ueln
@Sﬂmﬂ%
R
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Options include three panes but only Environment is relevant with ViSi-Genie, which is code-less. The Compiler
and Editor panes deal with code.

Environment | Compiler Editor

Reopen Files Image / Video Resample Quality
@) Fastest
¥ Show Hints & rastes
() Scaled
Save as Opens Both @ Box
Backup Files () Spline
() Bilinear
() Bicubic
Style: [DF’ﬁceZD 10Blue - () Lanczos

Tab Color .

Select the Style among different possibilities.

The Image / Video Resample Quality selection brings different options:
Fastest

Scaled

Box

Spline

Bilinear

o O O O O O

Bicubic
o Llanczos
Click Help to access help, with links to the 4D Systems website:

d New
I
| oo

| Recent

7 To access the 4D systems home page Workshop 4

] Version: 4.0.2.1
Save As Copyright: 2012 4D Systems

For Peer help and support
1_H Zip Project

lj Close other documentation visit the

on the page for your product
& Print Setup

B

IF ot
1 options

s0 see the Samples item for the location of va

(S) sewic
Ko
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Click Samples to access examples from 4D Systems, with pre-defined filters:

SAMPLES

ere loaded onto your hard drive as part of the installation
Workshop

24D Labs - Click to browse all files
‘Goldelox Designer - Click for filtered browse
Goldelox Visi - Click for filtered browse
Picaso Designer - Click for filtered browse
Picaso ViSi - Click for filtered browse
Picaso ViSi Genie - Click for filtered browse

st of application

Click here to visit the 4D App Notes

e the Help item for the location arious help information.

@ Save Changes to AN4 - Customised keyboard 4DGenie?

[ Yes Mo ][ Cancel ]

6. Designer Specific Menus

The Designer environment includes five menus:

6.1. Home Menu

The Home menu is the main menu...

= S Workshop 4 - NoNamel (uLCD-32PT, LANDSCAPE) .- ‘_=' [Slh] s
Home View Tools Widgets Comms Project @
i P . c \ \ _
= ‘ | I save %, B copy @ undo < @ @ < /)\ @ @ {;Q = Collapseal Q o
= = e saveas B raste | E§Redo "é ”é b = Bpand All
New  Open cut  ° ClearAll  Next  Prev  Set Find Replace Goto Find Again Compile Comp'nLoad
A Print K Delete
File Clipboard Undoy... Bookmarks Find Code Folding Compile

...with three groups of buttons:

. File-related commands,
o Build command,
. And the objects pane.

6.1.1. File-Related Buttons

The file-related buttons include the same commands as seen in the File menu: New, Open, Save, Save As and
Print.
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= | \ E Save
= e L E Save Az

Mew Open
& Print
File

6.1.2. Code Related-Buttons

The code related buttons include the standard Windows commands of Cut, Copy, Paste, Delete, Undo and
Redo.

o

%), il Copy @ Undo

I Paste & redo
Cut =

) aDeIete
Clipboard | Unday...

6.1.3. Bookmark Buttons

The bookmark buttons include Set a bookmark, go to Next or Previous bookmark and Clear All bookmarks.

% O 0 s

Clear All  MNext Prev Set

Bookmarks

Bookmarks are shown close to the line number:

=
Lo L

[T

Bookmarks are especially useful for large projects.
6.1.4. Find and Replace Buttons

The find and replace buttons provide the basic features for code.

@O G

Find Replace Goto Find Again

Find
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The Find button prompts for a string and highly it in the code:

I
[
[

13 |d..."}»

m

28 |"NoNamel.dan", "NoNamel.gcn"™, 1); // Open handle to access uSD fonts, uncc

¥E |xfr, 'r') : // Open handle to access uSD strings, [Hleleul=ige 1f requirsd

30 l'aMamail Ast™  "NaMamsi agei® 11«

< | 1 | 3
|

uncomment » F 4 P [[lwhole words [ Case Sensitive @) This file () Files in praj
|

-

Use the up and down arrows to look for the previous and next occurrence. Check Whole Words and Case
Sensitive. Choose between This file and Files in progress and All Open Files.

@ This file () Files in praject () All open files

The Replace button searches for a string and exchanges it with another string:

1 |#platform "uLCD-32ZPT GFX2"

| »

S/ Program Skeleton 1.0 generated 15/10/2012 14:27:3

o

m

5 |#inherit "&DGL_lEbitColours.fnc"
#inherit "VisuwalConst.inc"

2 |#inherit "NoNamelConst.inc"

11 |func main()

/¢f wvar hstrings ; // Handl

= to strings, uncomment 1f reguirsd
/4 var hFontx ; // Handle to
a 1F

fonts, uncomment 1f reguirsd an

-

14 |// [neomment the followina 1 5. fants ar strinTs nssd.
€| T | A

11510

|
uncomment * & 4 0 [Clwholewords [7]Case Sensitive @ This file () Files in proj

(\V)
0
2
]
| -
Y]
n
>
N
Q
(@]
L
n
RV
| -
=

- yﬂepﬂace @Replaoe all

Same options as for Find apply.

The Goto button prompts for a line number:

Goto Line A u
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6.1.5. Code Folding Buttons

The code folding buttons allow to collapse or expand a function:

CollapseaAll

e
P

Expand All

Code Folding

This is especially useful for large projects.

6.1.6. Compile Buttons

The Compile button launches the compilation of the project while the Comp’nLoad compiles and uploads the

&% O

Compile Comp'nLoad

project to the screen.

Compile

6.2. Menu Tools

I:EJ:I L2 Terminal 115200
- =

== £ = -
Graphics  PmmC  Terminal ﬁTDIJEh Calibration
Composg  Loader 9600

¥ 4DGL uvGA Link
All the tools and utilities are grouped here:

. Click PmmC Loader to start the PmmC Loader utility.

o Click ‘Terminal connect 9600’ to open the currently selected com port at 9600 baud in the
Terminal program.

. Click ‘Terminal connect 115200’ to open the currently selected com port at 115200 baud in the
Terminal program.

. Click Touch Calibration to calibrate the touch on the display.

. Click 4DGL uVGA Link to open a window which can interact with the uVGA, enabling a mouse and

keyboard to be used with the uVGA(GFX) module. Demo code is available from Workshop 4.

6.3. Comms Menu

This menu is in charge of the communication port:

= '
Home View Tools Widgets Comms  Project
Status at 14:27:36
COoM27 -
’7Devi-::e is not responding

Comms

The use of this menu is described at the section Connect the Display.
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6.4. Project Menu

The Project menu includes different parameters and options...

'IE|=

File Home \View Tools gets Project
e e
- - LANDSCAPE -
RAM | Flash
Destination Display

...with two groups of buttons:

. Destination,
. And display selection.

6.4.1. Destination

The first group includes the options for the destination:

T e
RAM | Flash

Destination

Select the Destination among two possibilities:

e RAM means the display must be connected curing build and that the program will be downloaded to
the display’s RAM memory once compiled.

e  Flash means the display must be connected curing build and that the program will be downloaded to
the display’s flash memory once compiled.

© 2012 4D SYSTEMS Page 25 of 36 www.4dsystems.com.au



Y
=,
=)
i8]
|
U
n
-
I
al
0
C
0
¥
|
2

40 SYSTEMS Workshaop 4 User Guide

6.4.2. Display Selection

The second section allows to select the screen. Clicking on the button...

uLCD-32PT
LANDSCAPE -

Display

...opens a new window to select the screen:

Crientation
|1 Portrait

i@ Landscape

|| Porfrait Reversed
(I Landscape Reversed

Select the screen from the drop-down list:

luLcD-32rT - |
ULCD-24PT
uLCD-24PTU
uLCD-28PT
uLCD-28PTU
uLCD-32032P1 g
uLCD-32PT

uLCD-32PTU

uLCD-32WPTU -

| »

m

Define the orientation among the four options:
Crientation
(| Portrait
@ Landscape
() Portrait Reversed
[ ) Landscape Reversed

Confirm by clicking on or deny by clicking on .
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7. ViSi Specific Menus

The ViSi environment includes all the menus available with the Designer environment plus two additional

EE ——
Jﬁ Home View Tools Widgets Comms Project

7.1. View Menu

The View menu includes one important tool for visualising the form:

Q00606

menus: View and Widgets.

Object Form  napshot Reset Object
Inspector p view Loaations

Possibly hidden Forms

Click on Snapshot to open a specific window of the form to enable a 1:1 screenshot of the display to me made.

& Snapshot . - |ﬂm
®

This window provides a zoom up to 4 times. The Save button allows to save the screen as an image.

Object Inspector, Form, and Reset View, all relate to the menus and tool bars used in Workshop 4. These
toolbars and menus can be moved and detached from the side of Workshop 4. Object Inspector and Form will
bring to front the relevant toolbar when clicked. If required, the toolbars can be reset back to their default
location by clicking the Reset View button.

Object Locations enables the user to copy the locations/coordinates of objects on the display, to the clipboard.

7.2. Widgets Menu

The Widgets menu includes the objects pane with all the objects available to build the interface:

i g = Workshop 4 - NoNamel (ul!
ﬁ Home View Tools Widgets| Comms Project
|Buttons ' Digits  Gauges  Primitves  Inputs  Label  System/Media

el

The objects —also called widgets—are detailed in the ViSi User Guide.
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8. ViSi-Genie Specific Menus

ViSi-Genie includes five menus with specific ribbons and options.

= e T
- ,
Home View Tools Comms Project

ViSi-Genie is codeless and thus completely different from the previous code-based environments, all the menus
relating to ViSi-Genie are detailed.

8.1. Home Menu

The Home menu is the main menu...

=] - Workshop 4 '
) B
File Home View Tools Comms Project

\_-1 ‘L H L—- = @, |Buttons (Digts Gauges Primiives Inputs ' Labels  System/Media @

s T . 8
New Open Save SaveAs Print Build [@ @ ﬂ:: m
A __

File Build

...with three groups of buttons:

o File-related commands,
. Build command,
. And the objects pane.

8.1.1. File-Related Buttons

The file-related buttons include the same commands as seen in the File menu: New, Open, Save, Save As and

Print.
e e

Mew Open Save SaveAs  Print

File
8.1.2. Build Button

The Build button launches the compilation and the upload of the project to the screen.

8.1.3. Objects Pane

The objects pane includes all the objects available to build the interface:

|Buttons  Digits  Gauges  FPrimifives  Inputs  Labels  System/Media @
ey T

The objects are detailed on the ViSi-Genie User Guide.
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8.2. View Menu

The View menu includes one important tool for visualising the form:

© 0069

Object e z hot Reset Object
Inspectar mrrm MEpEio View Locations

Possibly hidden Forms

Click on Snapshot to open a specific window of the form.
r@ Snapshot

=R
L, ==

2

©1020304

This window provides a zoom up to 4 times. The Save button allows to save the screen as an image.

8.3. Menu Tools

(H = % —
Boot PmmC Terminal % Touch Calibration

SD  Loader 9600 o
: pacer % 40GL uvGA Link

B @ [E] [¥1 Terminal 115200 i GTX

All the tools and utilities are grouped here:

o Click Boot uSD to upload the boot-loader to the screen.

. Click PmmC Loader to start the PmmC Loader utility.

. Click ‘Terminal connect 9600’ to open the currently selected com port at 9600 baud in the
Terminal program.

. Click ‘Terminal connect 115200’ to open the currently selected com port at 115200 baud in the
Terminal program.

J Click Touch Calibration to calibrate the touch on the screen.

. Click 4DGL uVGA Link to open an interactive window to use mouse/keyboard with the uVGA(GFX)
module.

o Click GTX to launch the Genie Test Executor debugger.
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Clicking the GTX button, a new screen will appear with the form and objects defined in the project:

Frlcene o

Control
Active Form
=

M
=

Queryvaies| 0 &

set

ter
ickb:

eters
rackbars
et

8.4. Comms Menu

This menu is in charge of the communication port:
=
Home WO
cOM27 - Status at 17:52:11
Com port not currently
.. available

Comms

ools” Comms | Project

The use of this menu is described in section 9 “Connect the Module”

8.5. Project Menu

The Project menu includes different parameters and options...

Project
Destinati
oestination Comms Speed: 9600 - - UIF;IEJ:E'—I'%;APT?J
” Flash " Run Flash ” ush — J u
Sound Buffer: 1024
Genie Display

..with three groups of buttons:

. Options for Genie,
. Parameters,
. And display selection.
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8.5.1. Genie Options

The first group includes the options for Genie:

Destination

” Flash ” Run Flash ” usD

e Select the Destination among three possibilities:
o Flash - The display must be connected during Build and the program will be downloaded to
the display’s flash memory once compiled. The users application will be stored in Flash, but

will be run from RAM.

o Run Flash - The display must be connected during Build and the program will be downloaded
to the display’s flash memory once compiled. The users application will be stored and run
from flash, this uses less memory on the display, but makes programs run slightly slower.

o uSD - The users application will be built and copied to the uSD card to be run from there. This
option requires the Boot uSD program to be uploaded to the display’s flash, as seen in the
menu Tools. This Boot uSD program loads the users application from the uSD card at startup,
and executes it.

Boot
usD

8.5.2. Parameters

The second group include advanced parameters:

Comms Speed: 9600 -

Sound Buffer: 1024 ~

e Comms speed Is the baud rate at which the serial command interface operates

o Define Sound buffer size for the amount of memory set aside for buffering wav (sound) files. For
simple sound files 1024 bytes should be enough. For complicate sound files to be played whilst video
is displaying may need as much as 4096 bytes.
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8.5.3. Display Selection

The last section allows selecting the screen, useful for converting a program from one display module to

- -

Display

another. Clicking on the button...

...opens a new window to select the screen:

Select the screen from the drop-down list:

luLcD-32rT - |
uLCD-29PT A
uLCD-29PTU ‘

Y
=,
=)
i8]
|
U
n
-
I
al
0
C
0
¥
|
2

uLCD-28PT
uLCD-28FTU
uLCD-32032F1 bl
uLCD-32PT

uLCD-32PTU

uLCD-32WPTU w7

Define the orientation among the four options:
Orientation
[ Partrait
@ Landscape
() Portrait Reversed
(") Landscape Reversed

Confirm by clicking on or deny by clicking on .

© 2012 4D SYSTEMS Page 32 of 36 www.4dsystems.com.au




(\V)
0
2
]
| -
Y]
n
>
N
Q
(@]
L
n
RV
| -
=

40 SYSTEMS Workshaop 4 User Guide

9. Connect the Module

Connect the module to a USB port with the 4D Systems programming cable and select the Comms menu:

- —-—
Home View Tools Comms Project

Above the Comms section, the violet light mentions no module is currently connected.

[—7] Please select an

.. available port

Comms

Connect the 4D Systems programming cable/adaptor to the module and plug the cable into the USB port.
Click on the drop-down list and select the COM port relating to the 4D Programming cable/adaptor.

ools® Comms | Project
Please select an
| - :
COM1E available port
I coM1g | _
Il comzo |E | Comms
COM21
COomM22 )
COM23 changing onChanged [x]
COM24
TormoeTTT
. |’_\
The light turns while the connection is being established:

Status at 11:3%:02
coM3 = =
Scanning Port

Comms

Finally, the light goes blue when the connection is established.

Status at 11:34:00
CoM3 -
ULCD-32PT [w3.0]

{0 {uSD: 1,86 GE)

Comms

The light turns red when no module is attached to the selected port:

Status at 12:24:13
COMZF -
The system cannot find
.. the file specified

Comms
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10. Insert the Micro-SD Card

The micro-SD card shall be FAT16-formatted. Partition can't exceed 2 GB.

For more information about formatting the micro-SD card, please check the details in the “Format the Micro-
SD Card” chapter, described in the Workshop 4 Installation document.

To connect the micro-SD card, either

e Insert the micro-SD card into the USB adaptor and plug the USB adaptor into an USB port of the PC.

€

e Insert the micro-SD card into a micro-SD to SD card converter and plug the SD card converter into the
SD card slot of the PC.

Or

Check the micro-SD card is mounted, here as drive E:.

G = » compuc»
Al

Organize = AutoPlay Eject Properties System properties  Uninstall or change a program ~ » B 0O @
7 Favorites 4« Hard Disk Drives (2) i
Local Disk {C:) Recovery (D)

2 Libraries > 1 —

g/ 501 GB free of 676 GB S 220 GB free of 214 GB
*d Homegroup 4 Devices with Removable Storage (2)

§A Removable Disk (F:)

18 Computer DVD RW Drive (E:) > [

Ci—$ 7”155 GB free of 186 GB

&, Local Disk (C)
a Recovery (D7)
e Removable Disk (F:)

€ Network
Removable Disk (F) Spaceused: | Total size: 1,86 GB
w7 Removable Disk Space fres: 1,85 GB File system: FAT
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11. Revision History

1.0 First Release Nov 19, 2012
11 Typos on Page 4 fixed Dec 17,2012
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12. Legal Notice

Proprietary Information

The information contained in this document is the property of 4D Systems Pty. Ltd. and may be the subject of
patents pending or granted, and must not be copied or disclosed without prior written permission.

4D Systems endeavours to ensure that the information in this document is correct and fairly stated but does
not accept liability for any error or omission. The development of 4D Systems products and services is
continuous and published information may not be up to date. It is important to check the current position with
4D Systems. 4D Systems reserves the right to modify, update or makes changes to Specifications or written
material without prior notice at any time.

All trademarks belong to their respective owners and are recognised and acknowledged.

Disclaimer of Warranties & Limitation of Liability

4D Systems makes no warranty, either expressed or implied with respect to any product, and specifically
disclaims all other warranties, including, without limitation, warranties for merchantability, non-infringement
and fitness for any particular purpose.

Information contained in this publication regarding device applications and the like is provided only for your
convenience and may be superseded by updates. It is your responsibility to ensure that your application meets
with your specifications.

Images and graphics used throughout this document are for illustrative purposes only. All images and graphics
used are possible to be displayed on the 4D Systems range of products, however the quality may vary.

In no event shall 4D Systems be liable to the buyer or to any third party for any indirect, incidental, special,
consequential, punitive or exemplary damages (including without limitation lost profits, lost savings, or loss of
business opportunity) arising out of or relating to any product or service provided or to be provided by 4D
Systems, or the use or inability to use the same, even if 4D Systems has been advised of the possibility of such
damages.

4D Systems products are not fault tolerant nor designed, manufactured or intended for use or resale as on line
control equipment in hazardous environments requiring fail — safe performance, such as in the operation of
nuclear facilities, aircraft navigation or communication systemes, air traffic control, direct life support machines
or weapons systems in which the failure of the product could lead directly to death, personal injury or severe
physical or environmental damage (‘High Risk Activities’). 4D Systems and its suppliers specifically disclaim
any expressed or implied warranty of fitness for High Risk Activities.

Use of 4D Systems’ products and devices in 'High Risk Activities' and in any other application is entirely at the
buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless 4D Systems from any and all
damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any 4D Systems intellectual property rights.

13. Contact Information

For Technical Support: support@4dsystems.com.au
For Sales Support: sales@4dsystems.com.au

Website: www.4dsystems.com.au

Copyright 4D Systems Pty. Ltd. 2000-2012.
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